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Concept

• A standard modelling interface to enable rapid 
model prototyping.

• Provides a User Interface (UI), management of 
model runs and a range of utilities, including 
plotting.

• Can easily be adapted. Depending on complexity 
of model may only need to write input definition 
and some code to call the new model.

• Can also extend GUI to add tabs and additional 
menu options.
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Common interface

Use the same underlying class interfaces
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ModelUI Structure 

Nov 23

Input UI

Data Input Main UI

Results
Model/Data 

Objects
Project

Data UI

Edit, Plot, 
etc

Change these to 

create a new model
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Input UIs and Tab display generated automatically
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Plotting, Editing and Derived output as part of UI
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Demonstration models in the ModelUI App

ModelUI handles model outputs that vary in any 
combination of variable, v, and dimensions x, y, z and t.

Models provided in the ModelUI App illustrate different 
types of application:
• Vertical Tidal Profile: simple x-v data set

• SimpleTide: time data (t-v and no x, y, z)

• 2D diffusion: variable in x, y, t (can also include z for 3D case)

Other Apps illustrate a wide range of applications
• Data analysis – CoastalTools, SedTools

• Models – Asmita, ChannelForm, WaveRayModel, CSTmodel

• Analysis – ModelSkill

• Design – MRBreach
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Summary

• The muitoolbox can handle multiple variables, with 

multiple dimensions: e.g. time and x, y, z.

• It is available as Open Source

• Download muitoolbox.mltbx file from: 
https://github.com/CoastalSEA/dstoolbox/releases/

• Online Help is available once toolbox is installed

• Manuals with worked examples available for all 

demonstration models and Apps
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Getting Started
Model to generate a simple tidal time-series
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Simple tidal signal model

Existing function to compute a tidal water level time 

series using main constituents scaled to required tidal 

amplitude.

Function name: simple_tide.m

Input is a structure for:
duration, time interval, mean tidel level, tidal amplitude, elevation phase, 

velocity amplitude, velocity phase, and amplitudes for M2, S2 and O1 

tidal constituents

Output is a structure for 

time, elevation, vertical velocity and horizontal velocity
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Install toolboxes and copy templates

Download and install dstoolbox and muitoolbox (see next slide) 

Create a new working folder 

Copy ~BlankAppFolders.zip file from …/muitoolbox/muitemplates

Unzip the contents into the working folder

Copy following templates from …/muitoolbox/muitemplates folder:

Note:

UseUI_template.m allows the UI to be customized

UseModelUI_template.m uses ModelUI as the user interface and requires ModelUI App 
to be installed

Nov 23

Source Rename as

UseUI_template.m TideUI.m

ParamInput_template.m TideParams.m

Model_template.m TideModel.m
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Installing the Toolboxes

28-Oct-2414

The toolboxes can be installed using the 

Add-Ons>Manage Add-Ons option on Home tab of Matlab  

Alternatively, right-click the mouse on the ‘mltbx’ files and 

select Install. 

All the folder paths are initialised upon installation and the 

location of the code is also handled by Matlab . 

The location of the code can be accessed using the options in 

the Manage Add-Ons UI (option on Home tab)



App folder structure  (using ~BlankAppFolders.zip and template files)

Nov 23

Rename

Manuals, Licence

Demo file of model

Help ‘m’ and ‘HTML’ files

Any other documents
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Add model to Working Folder

The model file can be found in the Working Docs 

folder extracted from the ~BlankAppFolders.zip file.

Move ‘simple_tide.m’ up to the working folder.

The working folder should now look like this:
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UseUI_template.m >> TideUI.m

To change the Class name throughout the file:

 In classdef select UseUI_template

 Editor tab>Find 

  ‘replace with’: TideUI > Replace All

Sections of code that need editing are indicated by comments 
such as:   % << Edit to classname

For this application the following functions need to be edited:
• setMUI

• setMenus and setTab

• setTabProperties and setTabActions

• setupMenuOptions

• runMenuOptions
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setMUI

function obj = setMUI(obj)
 %initialise standard figure and menus 
 % classes required to run model, format:
 % obj.ModelInputs.<model classname> = {'Param_class1',Param_class2',etc}
 %      % << Edit to model and input parameters classnames 
 obj.ModelInputs.Model_template = {'ParamInput_template’};
 %tabs to include in DataUIs for plotting and statistical analysis
 %select which of the options are needed and delete the rest
 %Plot options: '2D','3D','4D','2DT','3DT','4DT’
 obj.DataUItabs.Plot = {'2D','3D','4D','2DT','3DT','4DT'}; 
 %Statistics options: 'General','Timeseries','Taylor','Intervals’ '
 obj.DataUItabs.Stats = {'General','Timeseries','Taylor','Intervals}; 
 modelLogo = 'mui_logo.jpg'; %default splash figure - edit to alternative
 initialiseUI(obj,modelLogo); %initialise menus and tabs 
end

Nov 23

• Replace Model_template with TideModel

• Replace ParamInput_template with TideParams

• Delete unwanted Plot and Stats Uis (highlighted in blue)

 - For TideUI only {‘2D’} and {‘General’} are needed
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setMenus

The setMenus function defines the menu structure in 

the UI. These are in order from left to right on the UI

Sample code for Setup menu to define menu lists, 

callback functions and separators (if required):

Nov 23

Menus

Tabs

%% Setup menu -------------------------------------------------
menu.Setup(1).List = {'Import Data','Input Parameters','Run Parameters','Model Constants'}; 
menu.Setup(1).Callback = [{'gcbo;'},repmat({@obj.setupMenuOptions},[1,3])];
%add separators to menu list (optional - default is off)
menu.Setup(1).Separator = {'off','off','off','on’};     %separator precedes item

% submenu for Import Data (if these are changed need to edit
% loadMenuOptions to be match)
menu.Setup(2).List = {'Load','Add','Delete','Quality Control'};
menu.Setup(2).Callback = repmat({@obj.loadMenuOptions},[1,4]);

Top level menu name

Sub-menu list

Level 1

Level 2

Cell array of callback functions
• {‘gcbo’} passes control to next level

• @functions pass control to other 

functions in TideUI

Note that at each level List, Callback and Separator cell arrays must be the same size
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This adds menus to load data from a file

‘Run parameters’, not used 

and can be deleted

+ change 3 to 2, delete off.



setTabs

Default code shows the definition of 4 tabs and two 

sub-tabs on the Stats tab.

Nov 23

function [tabs,subtabs] = setTabs(obj)
%define main tabs and any subtabs required. struct field is 
%used to set the uitab Tag (prefixed with sub for subtabs). 
%Order of assignment to struct determines order of tabs in 
figure.
%format for tabs: 
% tabs.<tagname> = {<tab label>,<callback function>};
%format for subtabs: 
% subtabs.<tagname>(i,:) = {<subtab label>,<callback 
function>};
%where <tagname> is the struct fieldname for the top level 
tab.
tabs.Cases = {' Cases ',@obj.refresh}; % << Edit tabs to suit 
model 
tabs.Inputs = {' Inputs ',@obj.InputTabSummary};
tabs.Plot = {' Q-Plot ',@obj.getTabData};
tabs.Stats = {' Stats ',''};
subtabs.Stats(1,:) = {' Descriptive ',@obj.setTabAction};
subtabs.Stats(2,:) = {' Extremes ',@obj.setTabAction};
%if subtabs are not required eg for Stats
% tabs.Stats = {' Stats ',@obj.setTabAction};
% subtabs = [];

end

For the TideUI application the Stats 

sub-tabs are not required and can be 

deleted (highlighted in yellow). The text 

below then needs to be Uncommented to 

include just the top-level Stats tab 

(highlighted in green)
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setTabProperties

Nov 23

Defines where model input parameters are displayed.

function props = setTabProperties(~)
%define the tab and position to display class data tables
%props format: {class name, tab tag name, position, column width, table title}
% position and column widths vary with number of parameters
% (rows) and width of input text and values. Indicative positions:
% top left [0.95,0.48]; top right [0.95,0.97]
% bottom left [0.45, 0.48]; bottom right [0.45,0.97]
%        << Edit input properties classnames 
props = {... % << Add additional inputs and adjust layout
'ParamInput_template','Inputs',[0.95,0.48],{180,60},'Input parameters:';...
'ParamInput_template','Inputs',[0.45,0.48],{180,60},'Run parameters:'};

end

• Replace ParamInput_template with TideParams

• Delete second line (highlighted) but not cell end bracket
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setTabActions

Defines bespoke behaviour of tabs (if required)

Nov 23

function setTabAction(~,src,cobj)
%function required by muiModelUI and sets action for selected tab (src)
msg = 'No results to display';
switch src.Tag % << Edit match tab requirements
 case 'Plot’ 
  tabPlot(cobj,src);
 case {'Descriptive','Extremes’}                 %or 'Stats' if no subtabs
  cobj = getClassObj(obj,'mUI','Stats',msg);
  if isempty(cobj), return; end
  tabStats(cobj,src); 
end

end 

For the TideUI application the Stats sub-tabs are not required 

(highlighted text) and need to be replaced with ‘Stats’
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setMenuOptions

Edit calls for setup menu

Nov 2323  :

function setupMenuOptions(obj,src,~)
%callback functions for data input
switch src.Text
 case 'Input Parameters' % << Edit to call Parameter Input class
 ParamInput_template.setInput(obj); 
  %update tab display with input data
  tabsrc = findobj(obj.mUI.Tabs,'Tag','Inputs’);
  InputTabSummary(obj,tabsrc);

case 'Run Parameters' % << Edit to call Data Import class
ParamInput_template.setInput(obj); 
%update tab display with input data
tabsrc = findobj(obj.mUI.Tabs,'Tag','Inputs’);
InputTabSummary(obj,tabsrc);

 case 'Model Constants’
  obj.Constants = setInput(obj.Constants);
 end
end 

• Replace ParamInput_template with TideParams

• Delete Run Parameters case (highlighted)



runMenuOptions and Help

Edit calls for run menu

Help
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function runMenuOptions(obj,src,~)
%callback functions to run model
switch src.Text 
 case 'Run Model' % << Edit to call Model class
 Model_template.runModel(obj); 
 case 'Derive Output’
  obj.mUI.Manip = muiManipUI.getManipUI(obj);
end 

end 

• Replace Model_template with TideModel

%% Help menu ------------------------------------------------------
function Help(~,~,~)
 doc tideui   % << Edit to documentation name if available
end

• Note that model name is in lower case



Test the UI

In the Command Window type:

>>TideUI;

You should now have a working GUI!

It just does not do anything yet!!

Nov 2325  :



ParamInput_template >> TideParams.m

To change the Class name throughout file:

 In classdef select ParamInput_template

 Editor tab>Find 

  ‘replace with’: TideParams > Replace All

Sections of code that need editing are indicated by 

comments such as:    % << Edit to classname

As a minimum the following needs to be edited:

• Class properties (next slides)
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TideParams.m – setting the class properties

Nov 23

Edit highlighted text to define model variables
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properties (Hidden)
%abstract properties in muiPropertyUI to define input parameters
PropertyLabels = {'Parameter 1 short description',... % << Edit to property descriptions
  'Parameter 2 short description',...
           'etc'};
%abstract properties in muiPropertyUI for tab display
TabDisplay %structure defines how the property table is displayed 

end

properties
Parameter_1 %definition of parameter 1 % << Edit to property names
Parameter_2 %definition of parameter 2
etc             %there should be as many properties as labels

end 



Model Input Parameters

Nov 23

Variable Description

Duration 

Tinterval 

z0 

TidalAmp 

ElevPhase 

VelocityAmp 

VelocityPhase 

aM2                              

aS2 

aO1

duration (days)

time interval for simulation (mins)

mean tide level to ordnance datum (mOD)

tidal elevation amplitude (m)

phase of elevation (ie k.x) (rads)

tidal velocity amplitude (m/s)

phase of velocity (ie k.x+phi) (rads)

M2 tidal amplitude (m)

S2 tidal amplitude (m)

O1 tidal amplitude (m) 
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TideParams.m - properties

Nov 2329  :

properties (Hidden)
%abstract properties in muiPropertyUI to define input parameters
PropertyLabels = {'Duration (d)','Time interval (mins)'...
     'Mean tide level (mOD)',...
     'Tidal amplitude (m)',...
     'Elevation phase (deg)',...
     'Velocity amplitude (m/s)',...
     'Velocity phase (deg)',...
     'M2 tidal amplitude (m)',...
     'S2 tidal amplitude (m)',...
     'O1 tidal amplitude (m)'};
%abstract properties in muiPropertyUI for tab display
TabDisplay %structure defines how the property table is displayed 

end

properties
Duration %duration (days)
Tinterval %time interrval for simulation (mins)
z0  %mean tidel level to ordnance datum (mOD)
TidalAmp %tidal elevation amplitude (m)
ElevPhase %phase of elevation (ie k.x) (rads)
VelocityAmp %tidal velocity amplitude (m/s)
VelocityPhase %phase of velocity (ie k.x+phi) (rads)
aM2  %M2 tidal amplitude (m)
aS2  %S2 tidal amplitude (m)
aO1  %O1 tidal amplitude (m) 

end 

You can Copy and Paste this 

text from the file:  

mui_training_input_text.txt

You can Copy and Paste this 

text from the file:  

mui_training_input_text.txt



Test the Data Input

In the Command Window type:

>>TideUI;

In the model UI select

Setup>Input Parameters

Enter some data

See the input data on the Inputs tab

SAVE YOUR WORK (File>Save as)

But it still does not do anything!
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Model_template >> TideModel.m

To change the Class name throughout file:

 In classdef select Model_template

 Editor tab>Find 

  ‘replace with’: TideModel > Replace All

Sections of code that need editing are indicated by 

comments such as:    % << Edit to classname

As a minimum the following functions need to be edited:

• runModel

• modelDSproperties
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Model Output Parameters

Nov 23

Name Description Label Units

h Elevation Elevation (mOD) mOD

uV Vertical velocity Velocity (m/s) m/s

uH Horizontal velocity Velocity (m/s) m/s

simple_tide returns a struct with fields:

results.t – time (s)

results.z – elevation relative to datum (mAD)

results.dz – vertical velocity (m/s)

results.u – horizontal velocity (m/s)
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TideModel - runModel function
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Modify template as follows:

– handle to input parameters class

– call to simple_tide model

– format model time data

– convert model output to a cell 

array of variables (first cell is 

time so exclude in assignment)

– assign to dstable

– add additional meta data

– assign results to catalogue

%--------------------------------------------------------------------------
% Model code <<INSERT MODEL CODE or CALL MODEL>>
%--------------------------------------------------------------------------
inp = mobj.Inputs.TideParams; 
res = simple_tide(inp);
%now assign results to object properties 
modeltime = seconds(res.t); %durataion data for rows
modeltime.Format = 'd';
%--------------------------------------------------------------------------
% Assign model output to a dstable using the defined dsproperties meta-data
%-------------------------------------------------------------------------- 
%each variable should be an array in the 'results' cell array
%if model returns single variable as array of doubles, use {results}
res = struct2cell(res);
dst = dstable(res{2:end},'RowNames',modeltime,'DSproperties',dsp);
%--------------------------------------------------------------------------
% Save results
%-------------------------------------------------------------------------- 
%assign metadata about model
dst.Source = metaclass(obj).Name;
dst.MetaData = sprintf('Model run for %d days',inp.Duration);
%save results
setDataSetRecord(obj,mobj.Cases,dst,'model');
getdialog('Run complete');
end

You can Copy and Paste this text from 

the file:  mui_training_input_text.txt



TideModel - modelDSproperties function
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Modify template as shown:

A ‘dstable’ requires the properties being 

saved to be defined by a set of 

‘dsproperties’. The dsproperty structure 

has fields for the Variables, the Row 

(usually time) and any other 

Dimensions. Each of these has a sub-

structure with fields for the Name, 

Description, Unit, Label, and Format. 

The cell arrays assigned to this set of 

fields must be the same size for each of 

the top-level fields. In the example, 

Variables has a length of 3, whereas 

Row has a length of 1 and Dimensions 

is empty.

function dsp = modelDSproperties(~) 
%define a dsproperties struct and add the model metadata
dsp = struct('Variables',[],'Row',[],'Dimensions',[]); 
%define each variable to be included in the data table and any
%information about the dimensions. dstable Row and Dimensions can
%accept most data types but the values in each vector must be unique
%struct entries are cell arrays and can be column or row vectors
dsp.Variables = struct(... 

'Name',{'h','uV','uH'},...
'Description',{'Elevation','Vertical velocity',...
'Horizontal velocity'},...
'Unit',{'mAD','m/s','m/s'},...
'Label',{'Elevation (mOD)','Velocity (m/s)','Velocity (m/s)'},...
'QCflag',{'model','model','model'}); 

dsp.Row = struct(...
'Name',{'Time'},...
'Description',{'Time'},...
'Unit',{'d'},...
'Label',{'Time (d)'},...
'Format',{'d'}); 

dsp.Dimensions = struct(... 
'Name',{''},...
'Description',{''},...
'Unit',{''},...
'Label',{''},...
'Format',{''}); 

end

You can Copy and Paste this text from 

the file:  mui_training_input_text.txt



Test the model

In the Command Window type:

>>TideUI;

In the model UI select

 Setup>Input Parameters

•   Enter some data

•   See the input data on the Inputs tab

 Run>Run Model

•   When prompted, give the run a name

View the elevation results on the Q-Plot tab

Use Analysis>Plots menu to produce a range of plots
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View model output on Q-Plot tab
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Extension to load data

Copy dataimport_format_template from muitemplates folder

Rename as tideui_import.m

To change the function name throughout the file:

 In function definition select dataimport_format_template

 Editor tab>Find 

  ‘replace with’: tideui_import > Replace All

For this application, the following functions need to be edited:
• getData

• readInputData

• setDSproperties
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getData and readInputData

Edit the default template

– see next slide

– depends on format of data in 

source file

– format specification to read 

each line of data
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function dst = getData(~,filename)
%read and load a data set from a file
[data,~] = readInputData(filename); 
if isempty(data), dst = []; return; end

%set metadata
dsp = setDSproperties;

%code to parse input data and assign to vardata
mdat = datetime(strip(data{1},''''));
mtim = datetime(strip(data{2},''''));
myDatetime = mdat + timeofday(mtim);

% concatenate date and time
myDatetime = myDatetime-myDatetime(1);
myDatetime.Format = dsp.Row.Format;
vardata = data(3:end); %sorted data to be loaded

%load the results into a dstable 
dst = dstable(vardata{:},'RowNames',myDatetime,'DSproperties',dsp); 

end
%%
function [data,header] = readInputData(filename)

%read tidal elevation data.
dataSpec = '%s %s %f %f %f'; 
nhead = 1; %number of header lines
[data,header] = readinputfile(filename,nhead,dataSpec);     %see 
muifunctions

end



setDSproperties

File with data/time, elevation, vertical and horizontal velocity
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function dsp = setDSproperties()
%define the variables in the dataset
%define the metadata properties for the demo data set
dsp = struct('Variables',[],'Row',[],'Dimensions',[]); 
%define each variable to be included in the data table and any
%information about the dimensions. dstable Row and Dimensions can
%accept most data types but the values in each vector must be unique

%struct entries are cell arrays and can be column or row vectors
dsp.Variables = struct(... 

'Name',{'h','u','v'},...
'Description',{'Elevation','Vertical velocity','Horizontal velocity'},...
'Unit',{'mAD','m/s','m/s'},...
'Label',{'Elevation (m)','Velocity (m/s)','Velocity (m/s)'},...
'QCflag',{'data','data','data'}); 

dsp.Row = struct(...
'Name',{'Time'},...
'Description',{'Time'},...
'Unit',{'d'},...
'Label',{'Time'},...
'Format',{'d'}); 

dsp.Dimensions = struct(... 
'Name',{''},...
'Description',{''},...
'Unit',{''},...
'Label',{''},...
'Format',{''}); 

end



View imported data on Q-Plot tab
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Alternative is to set up a new data class

The DataImport_formatfiles_template is a class that uses the 
dataimport_format_template and allows the user to select from 
multiple format files that handle different file formats. Simply 
rename the file and classdef and edit the file list to match the 
new import_format_file names.

OR

The DataImport_template is a template for a new data import 
class. To use this option, rename the file, classdef and object 
calls where indicated (% << Edit to classname). Then edit the 
readInputData and setDSproperties functions, as shown for the 
input_format_file option above.

In both cases, edit call in the main UI to the new class name
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function loadMenuOptions(obj,src,~)
 %callback functions to import data
 classname = 'muiUserData';

e.g. in TideUI edit highlighted 

text to <data import classname>



Converting the model to an App

Matlab provide the tools needed to package models as 
an App. The default template structure is designed to 
make this easy to do. The main steps are as follows:

1. Edit the info.xml and create project file (*.prj)

2. Create the project help files and related utilities

3. Draft a manual - pdf format (if required)

4. Add documentation index

5. Package App

The following slides explain these steps in more detail
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Creating an App Package (step 1)

From the working folder
• In ‘info.xml’ file change ‘ModelUI’ to App name e.g., ‘TideUI’

• Add project file:
– On Matlab Apps tab select Package App.

– Complete the form to describe the App.

– Select the main file (‘TideUI’). This will populate the Files included list.

– Scroll down to shared resources and add 

o ‘doc’, ‘help’ and ‘example’ folders

o info.xml

o mui_logo.jpg

o tideui_import.m

– From the Files included list delete everything except the App specific 
classes and functions (in this case just keep TideModel.m, 
TideParams.m and simple_tide.m). To do this select files and left-click 
mouse and select Remove.
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Creating an App Package (step 1)

The package UI should now contain the following files:
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Help (1) – files in help folder (step 2)

Online documentation is defined in the ‘m’ files to be found in the 
‘help’ folder. When published*, html files with the same name are 
created in the ‘html’ sub-folder.
•  Edit the name of the file model_template.m to the model class name in lower 

case (tideui.m in this case).
• Edit the other file names to replace ‘model’ with some model specific name 

(e.g., ‘tui’ in this case).
• Edit the content of each file to document the model. The text and layout in the 

templates provide some indicative content.
– for details of the markup format see: Matlab Help > Publishing Markup

– for details of how the online help is configured see: Matlab Help > Display Custom 
Documentation 

• In each help file edit references to the manual and example folder, replacing 
‘xxx’ with the help prefix (e.g., ‘tui’ in this case).

• From the Matlab Publish tab, publish the files to the ‘html’ sub-folder.

To add a pdf manual, create a pdf with the same name as the App 
model class (TideUI in this case) and place it in the App ‘doc’ folder.
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*To publish an .m file, go the Publish Tab in Matlab and use the 

Publish menu option. This creates an html file in the html sub-folder



Help (2) – files in html folder (step 2)

In …/help/html folder
• Change file names of ‘xxx_example_folder.m’ and 

xxx_open_manual.m’, replacing xxx with help prefix (e.g. 
‘tui’ in this case)

• In these files:
– update the function name to match the file name.

– change the appname = ‘ModelName’ to the name of the model/App 
(‘TideUI’ in this case).

– In the xxx_open_manual.m file model modify fpath to the correct file 
name for the manual (e.g., ‘TideUI manual.pdf’).

• In ‘helptoc.xml’ file change all *.html file names to the help 
file names (e.g., ‘tui_menus’) and the labels to the App name 
(e.g., ‘TidalUI’):

Nov 2346  :

<tocitem target="tidalui.html">TidalUI



Help (3) - related utilities (steps 2 and 3)

If a manual is to be included (e.g.; to explain use cases 
and document the basis of the model, etc), this needs to 
be placed as pdf file in the doc sub-folder. The file name 
must be as defined in the xxx_open_manual.m, e.g.

  ‘TideUI manual.pdf’

Add a demo project mat file to the ‘example’ folder. 
• Note: if the folder is empty, it is not installed as part of the App

Draft a manual to document how the App works and the  
background information on the model implementation
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Create the App (steps 4 and 5)

Once help files have been setup and edited 

Set Matlab environment path to include the working folder.

• Add documentation index using:

>> builddocsearchdb(‘<full path name>\help\html’) 

• Build app by opening project file and selecting the ‘Package’ 

button.

• Install App.

The App should now be available to run from the Matlab APPS tab
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Further information

Toolboxes and Apps are explained at www.coastalsea.uk 

and can be downloaded at https://github.com/CoastalSEA 

When dstoolbox and muitoolbox are installed, further 

documentation can be accessed using the MatlabTM 

Supplemental Software documentation. 

Nov 2349  :

http://www.coastalsea.uk/
https://github.com/CoastalSEA


The dstoolbox

The dstoolbox is designed to store and manage multi-
dimensional data sets, including meta-data of the 
variables and all dimensions and manage access to a 
collection of classes that hold data sets using a 
catalogue. 

In the schematic outline dstb_usage is a class to 
illustrate how dstable, dsproperties and dscatalogue 
are used. 

Data are loaded into a dstable with relevant metadata 
added to the table and made accessible using 
dsproperties. Each time a class adds data a record is 
added using dscatalogue. 

The 'Format Spec' user functions, shown in the upper 
part of the figure, are implemented with functions, 
indicated by 'File Type' and 'Output Type', shown in 
the lower part of the figure. 

These define the meta-data of the data set being saved 
(and any input parameters, or details needed to read 
and load data from a file, depending on the 
application).
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The muitoolbox

The purpose of the muitoolbox is to minimise the effort in 
creating or prototyping an interface for a model or data 
analysis tool. 

Creating a new model requires 3 components to be defined, 
namely the interface (ModelUI in the above illustration), one 
or more classes to manage the input of model parameters (if 
required) and the classes to hold imported data, or running a 
model and storing the output. 

Central to this is the holding of input data in the Inputs 
property and accessing the data via the Cases property. In this 
context, Cases comprise a record of each Case and a dataset. 
The records are held in the Catalogue property and the dataset 
(an instance of the data or model class) in the DataSets 
property of muiCatalogue. 

Each data or model class stores the dataset in the Data 
property, with additional information held in the RunData 
property (e.g. holding input parameters of a model run). 

Any type of dataset can be stored in the Data property but 
when using the dstoolbox multidimensional data sets can be 
stored using dstable and a full set of meta-data attached using 
dsproperties. 

The overall architecture and the properties that provide the 
links between one class and another are shown in the flow 
chart below

Nov 2351  :


	Slide 1: Introduction to the muitoolbox
	Slide 2
	Slide 3: Concept
	Slide 4: Common interface
	Slide 5: ModelUI Structure 
	Slide 6: Input UIs and Tab display generated automatically
	Slide 7: Plotting, Editing and Derived output as part of UI
	Slide 8
	Slide 9: Demonstration models in the ModelUI App
	Slide 10: Summary
	Slide 11: Getting Started
	Slide 12: Simple tidal signal model
	Slide 13: Install toolboxes and copy templates
	Slide 14: Installing the Toolboxes
	Slide 15: App folder structure  (using ~BlankAppFolders.zip and template files)
	Slide 16: Add model to Working Folder
	Slide 17: UseUI_template.m >> TideUI.m
	Slide 18: setMUI
	Slide 19: setMenus
	Slide 20: setTabs
	Slide 21: setTabProperties
	Slide 22: setTabActions
	Slide 23: setMenuOptions
	Slide 24: runMenuOptions and Help
	Slide 25: Test the UI
	Slide 26: ParamInput_template >> TideParams.m
	Slide 27: TideParams.m – setting the class properties
	Slide 28: Model Input Parameters
	Slide 29: TideParams.m - properties
	Slide 30: Test the Data Input
	Slide 31: Model_template >> TideModel.m
	Slide 32: Model Output Parameters
	Slide 33: TideModel - runModel function
	Slide 34: TideModel - modelDSproperties function
	Slide 35: Test the model
	Slide 36: View model output on Q-Plot tab
	Slide 37: Extension to load data
	Slide 38: getData and readInputData
	Slide 39: setDSproperties
	Slide 40: View imported data on Q-Plot tab
	Slide 41: Alternative is to set up a new data class
	Slide 42: Converting the model to an App
	Slide 43: Creating an App Package (step 1)
	Slide 44: Creating an App Package (step 1)
	Slide 45: Help (1) – files in help folder (step 2)
	Slide 46: Help (2) – files in html folder (step 2)
	Slide 47: Help (3) - related utilities (steps 2 and 3)
	Slide 48: Create the App (steps 4 and 5)
	Slide 49: Further information
	Slide 50: The dstoolbox
	Slide 51: The muitoolbox

